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Bonus DVD software

Skill level

Requirements

Fedora Core 2 ISO images 
• SiSoft Sandra 2004 SP2b

Beginner

None

Time to complete
Varies

Popular Linux distros
The following table lists the 10 most popular Linux or “Unix clone” distributions, along with a short description of each. Note that 

the distributions in italics are either not freely available, or are other Unix clones (don’t specifically use a Linux kernel).

Mandrake
The main goal of the Mandrake project is to make Linux easier to use and 
thus bring Linux to the masses. This has seen Mandrake become the most 
frequently-used distribution (at the time of writing). Mandrake is updated 
often, giving users the latest software as soon as each package is stable.

Fedora The Fedora project is assisted by Red Hat in order to develop and maintain 
a mainstream Linux operating system for general purpose use. Updates are 
available every three months, giving users reasonably new versions of most 
packages. This OS is also used as a long-term stability testing ground for Red 
Hat’s server product, Red Hat Enterprise Linux.

Debian The distribution for power users, Debian has a reputation for being a little 
less user-friendly, but incredibly stable. Part of the reason for this is the 
thorough testing process all packages must go through before becoming a 
part of the distribution — stability is often favoured over having the latest 
version of each package available.

Knoppix 
Knoppix is a version of Linux that doesn’t need to be installed on a hard 
disk in order to run, it boots directly from CD. It’s ideal for demonstration or 
rescue purposes, and allows for up to 2GB of (compressed) software to be 
installed on the CD.

SUSE SUSE, now owned by Novell, has a very large development team dedicated 
to the project. As a result, this distribution is good if you must have the 
latest of everything. In particular, SUSE was one of the first distributions to 
offer x64 support.

Slackware
Focusing on both ease of use and stability, Slackware was one of the first 
Linux distributions to achieve wide acceptance. It’s refreshed every few 
months.

Gentoo Aimed more towards developer and network professional users, Gentoo 
mixes elements of BSD-style operating systems with Linux. The “Portage” 
package management application is based on the tradition of BSD ports. 
Speed and efficiency are the paramounts of this distribution.

FreeBSD A free version of University of California’s BSD Unix, FreeBSD isn’t technically 
a Linux distribution. However, the philosophy of the GNU movement is 
preserved, giving students, researchers and professionals an environment 
that closely matches BSD at no cost. 

RHEL Red Hat’s Enterprise Linux (RHEL) is an enterprise-level Linux operating 
system. While not freely distributed, the licence fee goes towards Red 
Hat’s support plans. Providing such avenues for support is unique in the 
Linux market, and helps shift the onus from the user to Red Hat if there are 
problems with the OS itself.

Xandros
Formerly Corel-Linux, Xandros is more of a desktop operating system that 
emphasises compatibility with Windows systems. In addition to the free 
unsupported downloads, a number of supported versions are available after 
paying a fee. 

thus bring Linux to the masses. This has seen Mandrake become the most 
frequently-used distribution (at the time of writing). Mandrake is updated 
often, giving users the latest software as soon as each package is stable.

FreeBSD

Linux has gone mainstream since its first 

appearance in 1991. Nowadays, anyone familiar 

with a PC can use Linux. You no longer need to be 

on a first-name basis with Linus Torvalds in order 

to install it, and most distributions have so many 

bundled software packages that you don’t need 

to look anywhere else for a complete Windows 

alternative.

Best of all, Linux and the vast majority of 

applications that run on it are free, thanks to the 

popular GNU GPL (GNU’s Not Unix General Public 

License) scheme that is often used by the open 

source development community.

This is the first part of a comprehensive guide 

to Linux. If you have little or no experience with 

Linux, you’ll be a pro by the end of this series 

— even to the stage where Linux may well replace 

your Windows system.

DISTRIBUTIONS
Specifically, the kernel is all a Linux operating 

system is. All you need to do is install it. However, 

without other applications and utilities, your Linux 

system won’t do much more than waste CPU cycles.

While it’s possible to piece together your own 

Linux system from scratch, it can be incredibly 

tedious and labour-intensive. Most users start out 

with a distribution of Linux — a version of the 

kernel and suite of tools, applications and programs 

that give you the complete Linux experience.

There are hundreds of Linux distributions to 

choose from and each has its own niche. Some 

distributions mimic Windows and are intended for 

users new to Linux. Some distros aren’t updated 

frequently with the idea that system stability 

won’t compromise any mission-critical 

applications. Others include few packages and are 

designed for underpowered or embedded 

systems, while some ship with every package and 

line of source code imaginable.

When choosing a distro, you should ideally 

choose the one that best suits your needs. The 

table below provides a brief description of the 

aims of each distribution. Several Web sites are 

also dedicated to helping you choose the distro 

that suits your needs.

Most of the information provided here is 

non-distro specific. However, in order to give 

additional assistance to readers who are new 

to Linux, the Fedora Core 3 distribution of Linux 

is used to demonstrate each aspect of the 

operating system. 

WHY FEDORA?
There are a number of reasons why Fedora is 

used in this guide. For starters, it’s one of the 

most popular distributions and it has a wealth of 

online support. 

Part 1 Preparing for Linux
Before you can get Linux up and running, you need to prepare 

your PC for the transition. Jarrod Spiga explains.
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Fedora is a feature-rich distribution 

aimed at general purpose use, and new 

packages aren’t included in the project 

until they’ve been thoroughly tested. As a 

result, it’s not as bleeding-edge as some, 

but offers more stability. 

PREPARING TO INSTALL
As with the installation of any operating 

system, a number of preparatory steps 

should be taken first. In recent years, 

distribution developers have greatly 

improved the installation interface. While 

the days of awkward text-based interfaces 

are long gone, you can still get stuck if you 

aren’t properly prepared.

IDENTIFYING YOUR HARDWARE
Before installing any operating system 

(including Windows), it’s a good idea to 

make a note of the hardware installed on 

your system. 

Most Linux installers correctly identify 

hardware, but occasionally you may have to 

give specific configuration details to the 

installer. This is where a detailed inventory 

comes in handy.

If your list of hardware goes into great 

depth, you’ll be more likely to correctly 

answer any questions the installer throws at 

you. At bare minimum, you should 

complete the following list:

n Memory Capacity (in MB)

n CPU model; clock rate (in MHz); 

supported architecture (Athlon, i386, 

i586, i686, ia32e, ia64, ppc64, s390 or 

x86_64); and whether you use SMP or 

Hyper-Threading

n Graphics card chipset and memory (in MB)Graphics card chipset and memory (in MB)

n Hard drive capacities (in MB) and interface Hard drive capacities (in MB) and interface 

channel each drive is connected to

n Network devices and communications Network devices and communications 

hardware (including chipsets).hardware (including chipsets).

If you’re familiar with your system, If you’re familiar with your system, 

you should be able to compile this list you should be able to compile this list 

without looking inside your system. If not, without looking inside your system. If not, 

you can get most of the information by you can get most of the information by 

opening up your system, or by using SiSoft opening up your system, or by using SiSoft 

Sandra (included on this month’s cover Sandra (included on this month’s cover 

DVD). Install the application to your system, DVD). Install the application to your system, 

launch it, and go to File > Create a Report launch it, and go to File > Create a Report 

Wizard. Proceed through the wizard and Wizard. Proceed through the wizard and 

ensure that all of the information modules 

are selected. Save the report to the hard disk 

as a text file and keep a printout handy.

EVALUATING YOUR HARDWARE AND 
ANTICIPATING PROBLEMS IN ADVANCE
Hardware compatibility is a problem that 

Linux has recently (for the most part) 

overcome. There was a time when 

you had to go through every 

component in your system and 

double-check that it would work under 

Linux. But fgenerally, unless you have 

hardware that is rare or unique, it will 

work with Linux.

However, there are cases where it’s 

prudent to perform some checks — that 

way you won’t get into Linux and find out 

that a modem or soundcard won’t work 

as intended.

The most common piece of hardware 

that won’t work is the WinModem — an 

internal dial-up modem that relies on the 

Windows driver model to operate (as 

opposed to using a serial port). Many 

internal modems are WinModems, and 

since Linux uses a different driver model to since Linux uses a different driver model to 

Windows it has a hard time communicating Windows it has a hard time communicating 

with them. It’s best to check whether your with them. It’s best to check whether your 

device is compatible with Linux by going to device is compatible with Linux by going to 

the modem manufacturer’s Web site.the modem manufacturer’s Web site.

You should also check the Web site of You should also check the Web site of 

your printer’s manufacturer. A number of your printer’s manufacturer. A number of 

printer makers can supply native Linux printer makers can supply native Linux 

drivers for their drivers for their 

hardware, hardware, 

while while 

others 

may be 

able to point you toward another driver that able to point you toward another driver that 

your printer can emulate. If your printer 

software had special functionality under 

Windows (such as the ability to tell you 

when your printer cartridge is running low), 

be prepared to lose some of these features.

It’s also a good idea to check the 

compatibility of soundcards, TV tuners and 

video capture devices. Manufacturers of a 

lot of these devices use sound or video 

processors that are supplied by other chip 

makers. To determine whether your card is 

Linux friendly, search for the compatibility 

status of the sound or video processor.

Although Fedora has no problems 

detecting, installing on and booting to Linux 

from Serial ATA drives, a number of other 

distributions (such as the current stable 

release of Debian) have trouble with it.

Red Hat has a database of hardware 

(http://hardware.redhat.com/hcl) that is 

either certified for use with, or is known to 

work with Red Hat Linux versions. While the 

hardware detailed in this database has only 

been tested with various Red Hat versions, it 

can be used as a general guide for Linux — 

if it works with Red Hat, it should work with 

other distributions. 

DETERMINING MINIMUM SYSTEM SPECS
A main advantage of becoming familiar A main advantage of becoming familiar 

with Linux is that it runs remarkably well with Linux is that it runs remarkably well 

— even on dated hardware. In general, — even on dated hardware. In general, 

it’s how you plan to use Linux that 

determines your minimum specification, 

rather than Linux itself.

Fedora has the following suggested 

minimum system requirements:

n Pentium, Celeron, Athlon or Duron 

processor running at 400MHz or greater

n 128MB of system memory

n 3GB of available hard disk space

Hardware:  check the compatibility of your hardware   check the compatibility of your hardware 
before installing Linux. That way, you can anticipate before installing Linux. That way, you can anticipate 
problems later.

Detailed inventory:  Sandra can create 
detailed hardware reports on your system 
in minutes.
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Option summaryIf your system doesn’t meet these 

specifications, Fedora can still be installed. 

However, a system that doesn’t meet this 

specification may run a lot slower than one 

that does meet it. 

In fact, advanced Linux users often 

keep systems below this spec for certain 

purposes. For example, if a user wanted 

a Linux PC to only act as a firewall, they 

could install a minimum package on a 

considerably slower PC and get acceptable 

performance. However, the video editing 

performance of this PC would be dismal. 

If you’re new to Linux, try to exceed the 

minimum specification by as much as 

possible. In particular, the more RAM and 

hard disk space you can allocate, the better.

One last note: you need 128MB of 

available system memory if you want to run 

Linux Desktop (a graphical user interface 

similar to Windows) on a Fedora PC, 

otherwise the Linux Desktop won’t load. 

MAKING SPACE ON YOUR SYSTEM
Before Linux can be installed, there must 

be suitable and sufficient free space on 

the hard disk. Sadly, it’s not as simple as 

opening Windows Explorer to find out how 

much room is available on your C:\  drive. 

Linux uses a different file system 

structure to Windows, which means you 

must have separate hard disk partitions for 

your Windows and Linux installations.

In order to make room for Linux, you 

have a couple of choices available.

n Linux enthusiasts will say that you don’t 

really need to use Windows at all, since 

Linux lets you do everything that you ever 

need to do on a PC. As a result, you should 

wipe your existing hard disk, get rid of the 

Windows partitions and install Linux.

However, most people know that a 

number of applications only run under 

Windows with no open source equivalents 

(such as accounting applications).

Completely wiping your hard disk is an 

option, but if you’re new to Linux you’ll 

probably want to be able to occasionally 

jump back into Windows. 

Whatever your viewpoint, backup all 

your data before diving into Linux (and 

certainly before wiping your hard drive).

 Very simple; free.

 Windows is gone!

n A more sensible option for users new 

to Linux is dual booting. This is where you 

break up each hard disk into a number of 

partitions, and install an operating system 

on a number of these partitions. A boot 

manager (installed in the boot sector of 

the hard disk) then allows you to select the 

partition you want to boot to.

This means you can have Windows 

and Linux on the same hard disk. However, 

Windows won’t be able to read the Linux 

partitions and in some cases, Linux will 

blissfully ignore the Windows partitions. 

Therefore, each operating system can 

only use the space you reserve for its 

own partition.

Setting up a dual boot system is pretty 

involved and time consuming. Most people 

who adopt this approach already have 

Windows taking up their entire hard disk. 

These users have two options: backup These users have two options: backup 

everything, remove all partitions on the everything, remove all partitions on the 

drive, then repartition and reinstall/install drive, then repartition and reinstall/install 

everything; or use a partition editing tool to everything; or use a partition editing tool to 

shrink the Windows partition, freeing up the shrink the Windows partition, freeing up the 

space to create Linux partitions. space to create Linux partitions. 

The latter option generally sounds 

better to many users, but any software that better to many users, but any software that 

messes with your partitions can easily messes with your partitions can easily 

render them inoperable. Whichever method render them inoperable. Whichever method 

you choose, make sure you’ve backed up you choose, make sure you’ve backed up 

your data.your data.

The process of setting up your system 

using both approaches is detailed a using both approaches is detailed a 

little later.little later.

Option summary

 Elegant solution; costs nothing.


Partition editing is messy; reinstalling is time 

consuming.

n The third option is to purchase an 

additional hard drive to install Linux on. additional hard drive to install Linux on. 

This solution is by far the easiest, but This solution is by far the easiest, but 

also the most expensive — and your PC’s also the most expensive — and your PC’s 

configuration might not be able to handle configuration might not be able to handle 

an additional drive.an additional drive.

This solution allows you to keep your 

existing Windows installation. When it existing Windows installation. When it 

comes to using a boot manger, you have the comes to using a boot manger, you have the 

most flexible options available: you can most flexible options available: you can 

either install a boot manager on the boot either install a boot manager on the boot Certified:  Red Hat’s Certified Hardware Compatibility database lets you know if your gear works with Linux.Certified:  Red Hat’s Certified Hardware Compatibility database lets you know if your gear works with Linux.Certified:
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Software RAID 
If your system has multiple hard disks of 
similar capacity available for the Linux 
installation, consider using a RAID setup. 
The lower RAID levels allow you to either 
increase the fault tolerance of your disk 
subsystem (via mirroring), or increase the 
disk subsystems performance (via 
striping). Higher levels usually let you to 
do both.

If there is a hardware RAID controller 
in your system, set up the RAID array there 
— hardware RAID solutions are the most 
reliable and generally perform better. If 
you don’t have a hardware RAID 
controller, you can still get some of the 
advantages of a RAID configuration via 
software. Software RAID gives you the 
ability to work with higher RAID levels, 
which most desktop controllers won’t 
allow you to do.

The process of setting up a software 
RAID array will be explained in part two 
of this series, so if you’re familiar with 
RAID and would like to give it a go, 
consider this when planning your 
partitioning scheme.

Option summary

sector of the hard drive that you boot to, or 

you can change your hard disk boot order in 

the BIOS, eliminating a boot manager 

altogether.

Best of all, you have a large and fast disk 

reserve for your Linux installation.

 Flexible and easy.

 Cost.

THE TWO-SHOE SHUFFLE
If you haven’t got the money to invest in 

a new hard disk for Linux, and you’re not 

totally convinced you can do everything 

that you’re used to in Windows on your new 

Linux installation, the only solution is to set 

up a dual booting system. 

There are two distinct things that must 

be done; make appropriate space and then 

fill it. The latter task is usually the simple one 

and involves the installation of your 

operating systems. However, there are still 

traps you can fall into. The majority of this 

task will be covered next month, when we 

install Linux.

In the meantime, ensure you have 

enough free space for your installation. 

Before you even think about starting, back 

up all your data. Even if you plan on only 

modifying your Windows partitions, this 

activity is fraught with danger. 

As mentioned earlier, there are two 

different ways to divide up your hard disk. 

You can delete everything from the hard 

disk and install Windows and Linux afresh, 

or you can keep your existing Windows 

installation and try to free up some space 

for the Linux installation.

THE RULES OF PARTITIONING
Before tinkering with the partition tables 

on any hard disk, decide which partitions 

will be created, where they’ll be physically 

located, what format of partition is required 

and how much space each partition should 

take up. When considering this, remember 

the following:

n The 1,024 cylinder boundary: the BIOS in 

some systems (particularly in older systems) 

aren’t able to boot to partitions that start 

after the 1,024th cylinder on the hard disk. 

Consider installing a small Linux boot 

partition at the beginning of the hard disk.

n Windows 95, 98, Me and NT generally 

need to be installed on primary partitions 

(Windows NT can be installed on logical 

partitions, but the boot program must be 

installed on a primary partition). The Linux 

boot partition (or root partition, if you aren’t 

creating a dedicated boot partition) must 

also be installed on a primary partition.

n You can create a maximum of four 

primary partitions on a drive, or three 

primary partitions with an extended 

partition. An extended partition can’t be 

formatted. Instead, it’s used to house one or 

more logical partitions.

n Partitions located towards the beginning 

of the hard disk generally perform the best. 

Using partitions towards the beginning of 

the hard disk for swap space can produce 

improved paging performance and better 

system performance.

n Most versions of Windows 95, 98 and Me 

can be installed on FAT (sometimes known 

as FAT16) and FAT32 formatted partitions. 

Windows NT can only be installed on FAT 

and NTFS4 partitions. Windows 2000, XP 

and 2003 can be installed on FAT32 and 

NTFS5 partitions. Most versions of Linux can 

only be installed on Linux Native partitions.

Linux requires at least two partitions: 

the root (/) partition and the swap partition. 

The root partition could be considered the 

equivalent to the C:\ drive under Windows 

(it’s where all the data on your system is 

stored). The swap partition fulfills the same 

purpose as the Windows Page File; it swaps 

pages of memory to and from the hard disk. 

While Windows can store its page file on 

any drive in your system, Linux will only use 

partitions assigned as swap space.

While you only need two partitions to 

use Linux, it’s a good idea to set up a /boot 

partition at the very beginning of your drive. 

This will almost always prevent any problems 

caused by the 1,024 cylinder BIOS limitation. 

Doing this also allows you to install Linux on 

a logical partition. The /boot partition only 

needs to be a minimum of 75MB.

Advanced users can also create a 

number of other partitions. For instance, if a 

Linux PC was to be used as a file server, 

setting up a dedicated /home partition 

prevents the system from crashing if that 

partition fills up. Once you’ve decided on 

the Linux partitioning structure, plan out 

your Windows partitions.

TRASH IT ALL
Deleting everything from your hard disk 

gives you a nice clean slate to work with. 

Best of all, it gives you a lot of flexibility in 

where you situate different partitions. If 

you set your partitions up in the correct 

manner, you can achieve slightly better 

disk performance.

Before trashing everything on your 

drive, think about how you’re going to 

create your new partitions. It’s a little more 

difficult to do if you’re installing Windows 

95, 98 or Me. These three don’t give you the 

ability to tailor your partition sizes from 

within the installer, they simply install 

themselves on the hard disk’s active 

partition. In the event that no partitions 

exist, the installation processes of these 

versions of Windows create a single 

partition that’s the size of your entire hard 

disk, and installs Windows to that.

If you’re going to use one of these three 

operating systems, partition your system 

before installing them. To do this, format a 

bootable floppy disk from within Windows 

and copy the fdisk.exe utility to it. Reboot 

your system with this floppy in your drive 

and create the partition structure using fdisk.

Ensure the Windows 95, 98 or Me 

partition is a primary partition, and that it’s 

marked as the active partition before you 

exit fdisk.

If you’re installing Windows 2000, XP or 

Server 2003, you can add or remove 

partitions from within the installer (this is 

the same for Linux). As a result, all Linux and 

Windows partitions can be created from 

within the installer. 

The Windows 2000, XP, Server 2003 

installer and the fdisk application won’t 
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let you create native Linux partitions. To 

“reserve” space for Linux partitions at the 

beginning of your drive (for /boot and swap 

partitions, for instance), create partitions 

from within the installer/fdisk that cover 

that space. You can then delete these 

partitions from within the Linux installer 

and recreate them.

As you make changes to the partition 

table on the hard disk, keep a record 

of them on paper; doing this reduces 

the chances of accidentally modifying 

a partition.

It’s always a good idea to install 

Windows before Linux, as Linux’s boot 

loaders are a lot more configurable than 

Windows’. Windows 95, 98 and Me don’t 

even have boot loaders. The installation 

processes of these operating systems 

overwrite any boot loader on your system 

without asking, forcing you to boot to the 

OS that was installed last. 

MODIFYING PARTITIONS
If you don’t like the idea of completely 

wiping your hard disk, you might be able to 

modify existing partitions to make enough 

space for Linux. But you’ll need some 

additional software, such as PowerQuest’s 

PartitionMagic.

Partitioning tools are far from perfect, 

and it doesn’t take much modification to 

make a partition unusable. And back up all 

of your data before proceeding. 

While most partition management 

software allows for the creation of Linux 

partitions from within the application, this is 

unwise. It has been reported that some 

Linux installers aren’t able to properly read 

partitions created using these tools, and as a 

result, the installer can’t proceed.

To make the necessary space for Linux, 

you need to:

n Defragment the hard disk from 

within Windows (Start > Control Panel 

> Administrative Tools > Computer 

Management > Disk Defragmenter from 

within Windows 2000/XP/Server 2003)

n1  n  n Load the disk management software.

n2  n  n Resize the Windows partition, making 

sufficient space for Linux.

n3  n  n Move your Windows partition so there’s 

enough space before it to squeeze in your 

Linux /boot and swap partitions.

n4  n  n Apply the changes. This usually means 

rebooting the system.

Once your partition management software 

has done its stuff, you should be ready to 

install Linux.

GETTING A COPY OF FEDORA
At the time of writing, the latest version 

of Fedora was Core 2. However, Core 3 is 

scheduled for release on 1 November, 2004. 

The next few instalments of this guide are 

based around Fedora Core 3. Regardless, 

Fedora can be obtained in a number of ways 

and in a number of formats.

If you’re ready to jump into the thick of 

things now, and you have a CD or DVD 

burner, you can create a Fedora Core 2 

installation disc using this month’s cover 

DVD. Simply place the DVD in your drive and 

copy the four ISO images to your hard disk. 

You can then burn these images to CD using 

the following instructions.

(Alternatively, if you want to download 

Fedora Core 3 now, head to http://
fedora.redhat.com/download and 

download the appropriate images.)

To install Fedora Core 3, you only need 

the four main ISO images — the other 

images are only useful for advanced users 

(such as the SRPMS images which contain 

installers for all of the source code inside the 

Fedora project). 

If you have a DVD writer, download the 

DVD image. This is larger than 4GB, so make 

sure your current hard disk format supports 

files of this size (NTFS-formatted drives will, 

FAT16 and FAT32 partitioned drives won’t). 

Ensure your HTTP or FTP client also 

supports the transfer of files this size.

Fedora Core 3 will be on next month’s 

cover DVD. Best of all, the DVD is bootable. 

BURNING THE CD/DVD
If you’ve downloaded ISO image files (or 

copied them from the cover DVD), burn 

them to a CD/DVD. ISO files are complete 

disk images, not single files that can be 

burned directly to CD.

Most CD writing applications should be 

able to write ISO images to CD or DVD, 

including Nero’s Burning ROM and 

Adaptec’s Easy CD Creator. The following 

steps should work for the majority of 

burning apps:

n Open the CD/DVD burning application 

and cancel any wizard screens that pop up

n Select File > Open, and select the 

first ISO image. A write media window 

should appear

n Insert blank media into your drive and hit 

the button that starts the burn

n Repeat the process for the remaining 

ISO files.

Most importantly, test the burnt media by 

putting the disc containing the first image 

into the drive and restarting your computer. 

n Load your disk management software (in this case, Load your disk management software (in this case, 
PartitionMagic) after defragging the drive.1

Partition magic:  a typical dual-booting partition scheme with 50MB /boot, 512MB swap, 7.52GB Windows and 
5.91GB Linux / partitions.
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Next month . . .

The next installment of 
Mastering Linux will include 
a step-by-step installation 
guide for Fedora Core 3. 
Accompanying the 
distribution on the cover 
DVD will be a large image 
gallery, so you know what 
to expect when going 
through your installation 
— from when you first put 
CD/DVD into drive, until 
you boot to the Linux 
desktop. We’ll also show 
you how to set up printers, 
scanners, cameras and 
other peripherals, then 
finish off with automating 
the process of updating 
your system.

With any luck, your system will boot from the 

optical media. If not, go to the drive booting 

priorities within BIOS and ensure that your optical 

drive is set with a higher boot priority than your 

hard drive. If the drive is already set to a higher 

boot priority, or you don’t have the ability to set it 

so, you need to create boot floppies (as outlined 

in the next section). 

Once you’ve successfully booted to the media, 

enter the following at the prompt:

linux mediacheck

This command performs a scan of your CD or DVD 

media in order to verify its integrity. Embedded 

into each ISO image is an MD5 checksum. The 

scan simply goes through the process of calculat-

ing an MD5 sum based on the contents of the 

CD/DVD, and compares the result to the value 

embedded in the image. If the values match, you 

have a good burn.

CREATING BOOT FLOPPIES
If you can’t boot directly to your CD or DVD drive, 

you need to make a bootable floppy disk to get 

your installation started. Creating the boot floppy 

isn’t as simple as copying files to a disk — you 

need to prepare the disk in order for it to function 

properly.

First, grab a high-density (1.44MB) 3.5in floppy 

disk. If this disk holds data you want to keep, back 

it up. Bring up a command prompt by going to 

Start > Run > cmd (or command under Windows 

95/98/Me). At the prompt, enter:

format a:

where a: is the drive letter corresponding to the 

floppy drive your disk is in. You should be asked to 

confirm that you want to reformat this disk. When 

this is complete, you’ll be prompted to enter a 

volume label. Leave the label blank. Once the 

floppy disk is freshly formatted, it’s time to get the 

boot image onto the disk.

Insert the first Fedora installation CD or the 

DVD into your optical drive and enter the 

following commands (assuming that D:\ is the 

drive your installation media is in):

c:\> d:

d:\> cd \dosutils

d:\dosutils> rawrite

Enter disk image source file 
name: ..\images\bootdisk.img

Enter target diskette drive: a:

Please insert a formatted dis-
kette into drive A: and

press --ENTER-- : [Enter]

The rawrite utility on the first installation CD 

will copy the floppy boot image to your freshly 

formatted floppy disk. Once the copy has 

completed, you should be able to boot to this 

floppy disk, which will detect and initialise the 

installation CD.

n Shrink the Windows partition to make room Shrink the Windows partition to make room 
for Linux.2 n Move the Windows partition to make room Move the Windows partition to make room 

for the /boot partition. 3 n Apply the changes and reboot.4

ISO metric:ISO metric:  most users only need to download the non-SRPMS ISO images.  most users only need to download the non-SRPMS ISO images.


